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1. Введение 
 
Трекер TR-101/TR-102 – компактное устройство с встроенными модулями GPS и GSM для удаленного 
позиционирования человека.  
Текущие координаты (широта и долгота) передаются либо через SMS на мобильный телефон, либо на 
персональный компьютер по сети Интернет посредством GPRS1 (только TR-102), и затем используются 
картографическим ПО для отображения местоположения на карте.  
У трекера есть три кнопки быстрого дозвона и одна кнопка экстренного вызова. TR-101/TR-102 может 
использоваться для быстрого поиска детей и пожилых людей. Область применения может быть значительно 
расширена для решения задач поиска или контроля перемещения людей, животных, автомобилей, курьеров, 
ценных грузов. 
 
 
2. Особенности 
 

• GPS/GSM персональный локатор  
• GSM/SMS (TR-101) или GSM/SMS/GPRS связь (TR-102)  
• Всенаправленная высокочувствительная GPS антенна обеспечивающая отличное качество приёма 

сигналов спутников в условиях города  
• Применение новейших технологий и GPS чипсет последнего поколения SiRF Star III делают 

возможным точное определение координат даже в условиях слабых и переотраженных сигналов  
• Удаленное управление устройством через мобильный телефон или с помощью ПК в режиме on-line  
• Возможность приема входящих звонков для двухсторонней связи  
• Фильтрация входящих звонков – только 10 предварительно запрограммированных телефонных 

номеров могут и осуществлять контроль его местоположения  
• Возможность скрытого наблюдения за движением объекта без установления связи с ним – мониторинг 

в режиме реального времени  
• Определение текущего местоположения трекера нажатием всего одной кнопки на ПК или отправкой 

одного SMS-сообщения  
• 3 кнопки быстрого дозвона по предварительно запрограммированным телефонным номерам  
• GSM 850/1800 МГц (Европейская версия), GSM 900/1900 МГц (Американская версия) и GPRS класс 12 

(TR-102)  
• Кнопка SOS отправляет координаты и сигнал тревоги через SMS по трем предварительно записанным 

в памяти телефонным номерам (эти номера могут отличаться от номеров быстрого дозвона)  
• Подключение к ПК для настройки трекера и программирования номеров быстрого дозвона и отправки 

тревожного сообщения осуществляется через USB-порт (кабель mini-USB входит в стандартный 
комплект поставки)  

• Возможность программирования временного интервала для автоматической отправки текущего 
положения владельца трекера. Например, можно запрограммировать отправку текущих координат 1 
раз в час (только в режиме GPRS) 

• Сигнализация низкого уровня заряда батареи  
 
 
Особенности ПО:  
 
Прилагающееся программное обеспечение (ПО) «Call Center» или «ТрекМастер», работающее под Windows 
98/2000/XP, способно одновременно отслеживать передвижения до 5 трекеров через SMS («ТрекМастер») 
или GPRS1 («Call Center» или «ТрекМастер») и отображать их положение на картах Google. Все права на 
картографические изображения принадлежат компании Google (www.google.com). 
 
--------------------------------- 
1. Внимание! Для использования трекера TR-102 в GPRS режиме, ваш компьютер должен иметь 

РЕАЛЬНЫЙ IP-адрес!!! Этот адрес может быть статическим или динамическим. Если адрес 
динамический, вам необходимо использовать какой-либо из бесплатных DDNS-сервисов: 
www.no-ip.com, www.dyndns.com, www.changeip.com, www.dynu.com, www.ddns.nu, 
www.dtdns.com, www.zoneedit.com. 

 

http://www.google.com
http://www.no-ip.com
http://www.dyndns.com
http://www.changeip.com
http://www.dynu.com
http://www.ddns.nu
http://www.dtdns.com
http://www.zoneedit.com


3. Различия TR-101/TR-102 
 
 

 TR-101 TR-102 

Кнопка SOS P P 

Двусторонняя голосовая связь по GSM каналу P P 

Контроль положения по SMS каналу P  P* 

Контроль положения по GPRS1 каналу - P 

 
*. Если TR-102 в данный момент работает в режиме GPRS, он не будет посылать ответную SMS с 
определёнными координатами. Текущий режим (SMS или GPRS) настраивается в конфигурационной 
программе. 
 
 
 
Что выбрать пользователю 
 

Пользователь… TR-101 TR-102 

   имеет телефон сотовой связи P P 

   имеет доступ к компьютеру, подключённому к Интернет P P 

   нуждается в диспетчерском программном обеспечении* - P 

   нуждается в подробной карте местности* - P 

   имеет возможность установки ПО на сервер компании - P 

 
*. Компании ООО «ГлобалСат» (Россия) и GlobalSat Technology Corporation (Taiwan) не предоставляют 
указанное диспетчерское программное обеспечение и картографические материалы. ПО и карты вы можете 
приобрести у компаний, список которых представлен на сайте www.globalsat.su. 
 
 
 
--------------------------------- 
1. Внимание! Для использования трекера TR-102 в GPRS режиме, ваш компьютер должен иметь 

РЕАЛЬНЫЙ IP-адрес!!! Этот адрес может быть статическим или динамическим. Если адрес 
динамический, вам необходимо использовать какой-либо из бесплатных DDNS-сервисов: 
www.no-ip.com, www.dyndns.com, www.changeip.com, www.dynu.com, www.ddns.nu, 
www.dtdns.com, www.zoneedit.com. 

http://www.globalsat.su
http://www.no-ip.com
http://www.dyndns.com
http://www.changeip.com
http://www.dynu.com
http://www.ddns.nu
http://www.dtdns.com
http://www.zoneedit.com


4. Спецификации 
 

*Возможно изменение характеристик без предварительного уведомления. 
 

GSM модуль:  

Диапазон 
GSM 850/1800 МГц (Европейская версия),  

GSM 900/1900 МГц (Американская версия) 

GPRS class 12  

GPS приемник:  

GPS чипсет SiRF Star III  

Частота L1, 1575.42 МГц  

Количество каналов 20, "All-in-View"  

Антенна всенаправленная спиральная 

Точность:  

Определение скорости 0.1 м/сек, 95% (селективный доступ отключён)  

Определение времени 1 мкс, синхронизация по атомным часам GPS спутников  

Датум WGS-84  

Время захвата позиции:  

Обновление данных 0.1 сек.  

Горячий старт 1 сек., в среднем  

Тёплый старт 38 сек., в среднем  

Холодный старт 42 сек., в среднем  

Ограничения:  

Максимальная высота До 18000 м (60000 футов)  

Максимальная скорость До 515 м/с (1000 узлов)  

Максимальная вибрация 20 м/сек3  

Максимальное ускорение До 4g  

Характеристики окружающей среды:  

Температура эксплуатации - 20° ~ + 55°C  

Влажность 5 - 95%, не конденсированная  

Питание:  

Li-Ion аккумулятор 3.7 В, 1300 мАч  

Напряжение З/У 5 В 

Время работы в дежурном режиме до 100 часов (зависит от режима использования) 

Время работы в режиме разговора 5 ~ 6 часов  

Физические характеристики:  

Габариты 115 x 45 x 22.5 мм  

Светодиодная индикация 

- питание;  

- статус GPS;  

- статус GSM;  

Кнопки управления 

7 кнопок:  

- включение/отключение;  

- тревожная кнопка;  

- 3 кнопки вызова;  

- ответ/сброс звонка;  

- блокировка кнопок;  

USB порт мини USB порт для подключения к ПК  

 



5. Начало работы 
 
5.1 Комплектация 
 
Перед началом эксплуатации, обязательно проверьте комплектацию TR-101/TR-102. Если какой либо из 
компонентов отсутствует или поврежден, свяжитесь с продавцом. 
 

1. Трекер TR-101/TR-102 
2. Аккумуляторная батарея 1300 мАч 
3. Кабель USB 
4. Зарядное устройство 220 В 
5. CD-ROM 

 
Дополнительно могут поставляться: 
 

6. Чехол на пояс 
7. Зарядное устройство от прикуривателя автомобиля 

 
 

 

 
 
 

 
 

 
 
 

 

1 2 3 
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Перед началом использования TR-101 необходимо проделать следующие опреации: установить SIM-карту и 
аккумуляторную батарею, полностью зарядить аккумуляторную батарею. 
 
5.2 Установка SIM-карты и аккумуляторной батареи 
 
 

                    
 
 

1. Легко нажмите на крышку батарейного отсека и сдвиньте её вниз. 
2. Вставьте SIM-карту в держатель. Защёлкните держатель SIM-карты. 
3. Установите аккумуляторную батарею, чтобы её контакты совпали с контактами в нижней части 

батарейного отсека TR-101 
4. Установите на место крышку батарейного отсека и задвиньте её вверх до щелчка 

 
 
 
5.3 Зарядка батареи 
 
Для правильной работы трекера необходимо зарядить аккумуляторную батарею. Для этого включите 
прилагаемое зарядное устройство в гнездо трекера. Вилку зарядного устройства включите в сеть 
переменного тока 220 В. Дождитесь, пока погаснет оранжевый светодиод. Время полной зарядки – до 10 
часов.  

 
Внимание! Не используйте никакие другие аккумуляторные батареи, кроме входящей в комплект. 
Это может вывести прибор из строя.  
 
 

 
 
 



6. Конструкция трекера 
 
6.1 Внешний вид 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Блокировка кнопок 
2. Микрофон 
3. Индикация состояния питания 
4. Индикация состояния GPS 
5. Индикация состояния GSM 
6. Кнопка питания 
7. Кнопка SOS 
8. Крепление шнура для переноски 
9. Антенна GPS 
10. Динамик 
11. Кнопка ответа/окончания разговора 
12. Телефон 1/Прибавить громкость 
13. Телефон 2/Отключить микрофон 
14. Телефон 3/Убавить громкость 
15. Гнездо подключения питания 
16. Гнездо USB 
17. Крышка батарейного отсека 

 

9 

6 

7 
11 

1 
16 
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2 
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6.2 Органы управления 
 
 
Кнопка питания Включает и отключает трекер.  
  
Кнопка SOS Этой кнопке вы можете присвоить 3 телефонных номера. При нажатии на 

кнопку SOS, трекер определит вашу позицию и отправит её в виде SMS 
сообщения на эти номера. Сначала SMS будет отправлено на первый, потом на 
второй, затем на третий. 

  
Кнопка 
ответа/окончания 
разговора 

При поступлении входящего вызова нажмите эту кнопку (на 1-2 секунды), 
чтобы начать разговор. По окончании разговора нажмите её снова. 

  
Телефон 1/ 
Прибавить 
громкость 

Вы можете присвоить этой кнопке телефонный номер. При нажатии на неё, 
произойдёт вызов абонента. Во время разговора нажатие на эту кнопку (на 1-2 
секунды) увеличивает громкость динамика.  

  
Телефон 2/ 
Отключить 
микрофон 

Вы можете присвоить этой кнопке телефонный номер. При нажатии на неё, 
произойдёт вызов абонента. Во время разговора нажатие на эту кнопку (на 1-2 
секунды) отключает микрофон. 

  
Телефон 3/ 
Убавить громкость 

Вы можете присвоить этой кнопке телефонный номер. При нажатии на неё, 
произойдёт вызов абонента. Во время разговора нажатие на эту кнопку (на 1-2 
секунды) уменьшает громкость динамика. 

  
Индикация 
состояния GSM 

Синий светодиод 
Горит постоянно: трекер включён, но ещё не установил связь с сетью GSM  
Мигает часто (1 сек.): трекер в режиме набора номера, отправки данных по 
SMS/GPRS или разговора 
Мигает редко (3 сек.): трекер находится в дежурном режиме 

  
Индикация 
состояния GPS 

Зелёный светодиод 
Мигает: идёт поиск спутников и определение позиции.  
Горит постоянно (при этом синий мигает часто): трекер находится в online-
режиме GPRS 

  
Индикация 
состояния питания 

Красный светодиод горит постоянно: батарея разряжена, необходимо зарядить. 
Оранжевый светодиод горит постоянно: подключено зарядное устройство, идёт 
зарядка батареи. По окончании зарядки оранжевый светодиод гаснет. 
Этот индикатор также используется для подтверждения правильного нажатия 
кнопки SOS и подтверждения получения SMS адресатом. При этом он загорается 
на 1-2 секунды и гаснет. 

  
Гнездо 
подключения 
питания 

Для зарядки аккумуляторной батареи необходимо вставить в это гнездо круглый 
штекер зарядного устройства и включить его в сеть 220 В. 

  
Гнездо USB Подключив трекер к персональному компьютеру с помощью USB кабеля, вы 

можете произвести его настройку с помощью прилагаемого программного 
обеспечения. 

  
Блокировка 
кнопок 

Переключатель блокировки необходим для предотвращения случайного нажатия 
кнопок трекера. При включенной блокировке (переключатель сдвинут вниз по 
стрелке) любое нажатие кнопок будет сигнализироваться троекратным миганием 
всех светодиодов. Для разблокирования трекера, сдвиньте движок вверх. 

  
 
 



7. Установка и работа с программой «CallCenter» 
 
7.1 Установка драйвера USB 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                         Autorun Dialog box 
 
 
 
 
 
 
 
 
 
 
 
 
 
                            Dialog box 1                                        Dialog box 2 
 
 
1. Insert the CD into CD-ROM drive. When the autorun dialog box is displayed, click on "Install USB Driver" button 
to install the TR-101 driver. 
2. You will see dialog box 1, click on Next to continue. 
3. When installation is complete, click on Finish to close the dialog box 2. 
 
 
 



7.2 Установка программы «CallCenter» 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Autorun Dialog box 
 
 

 
 
Dialog box 1 
 
 

 
 
Dialog box 2 
 
 
1. From the autorun dialog box, click on the "Install PC Software" to install the Call Center program. 
2. Follow instruction of dialog box 1 to continue the installation. 
3. When the installation is complete, click on Finish in dialog box 2 to close the dialog box. 
 
 
 



7.3 Работа с программой «CallCenter» 
 
 

Пункт меню Панель 
инструментов 

Описание 

File > Save File (KML) 
 

Save the records as the KML format. You can import 
the KML file to Google Earth, and it will display the 
location route. This function only works under the 
"Search Records" mode 

File > Exit  Close the Call Center program 

View > GPRS Tracking 
 

Switch to GRPS Tracking mode. You can view the 
information of TR-102 which is on line 

View > Show Map  Check this item to show the location point in Google 
Map or Google Earth 

View > Search Records  

Switch to Search Records mode. You can inquire 
information of one user during a specific time. When 
you double click on one of these items, it will show 
the location point of this item on Google Map or 
Google Earth 

Management > User Information 
 Display the User Information. You can setup up to 5 

users in the Call Center 

Management > User Edit  

For deleting a user. The Call Center can only hold 5 
users’ information at most. If you want to add a new 
user after you have already set 5 users, please 
delete a existing one first 

Management > Setup 
 

When a TR-101/TR-102 is connected to your PC, you 
can do the basic setup to this TR-102 

GPRS > Start  
Start the Call Center connection to Internet. You can 
send the commands to TR-102 if the Call Center is 
connected online 

GPRS > Pause  

Pause the Call Center connection from Internet. 
While your Call Center is online, you can not enter 
the setup mode unless you pause the connection 
first 

GPRS > Send Command to TR-102  Send Command to TR-102 
Map > Google Map  Set to display the location point by "Google Map" 
Map > Google Earth  Set to display the location point by "Google Earth" 
About  Version information 
 
 



7.4 Основные настройки 
 
 
1. Присоедините USB-кабель одним разъёмом к трекеру, другим – к 
компютеру (предварительно установите драйвер USB, см. пункт 
7.1). 
 
2. Включите трекер, нажав и удерживая кнопку питания. 
 

• Дождитесь, пока закончится процесс инициализации трекера и 
светодиоды перестанут мигать поочерёдно. 

• Для переход в режим настройки, нажмите и удерживайте кнопку «Кнопка ответа/окончания 
разговора» в течение 10-15 секунд, пока все три светодиода не станут мигать одновременно. 

 
3. Запустите программу «CallCenter», кликнув два раза по ярлыку «TR102-Call 
Center» на вашем «Рабочем столе». 
 
4. Выберите пункт меню «Management > Setup», нажмите «Scan». Программа 
просканирует все имеющиеся в системе СОМ-порты и определит, к какому из 
них подключён трекер. 
 
5. Нажмите кнопку «Setup». Программа считает параметры трекера и откроет 
окно настроек. 
 
 
 
 

Внимание! Если SIM-карта защищена PIN-кодом, будет 
выведено окно «Enter SIM PIN», где нужно ввести PIN-код.  
Будьте внимательны!!! Если PIN-код будет введён 
неправильно три раза, SIM-карта будет заблокирована. В этом 

случае обратитесь к вашему оператору сотовой связи. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Закладка «Phone Mode» 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Пункт Опции Значение  
по-умолчанию 

Описание 

GPRS TR-102 передаёт данные по GPRS. Return Type 
(Режим работы) SMS 

SMS 
TR-101/TR-102 передаёт данные по SMS. 

Off 

При поступлении входящего вызова, трекер 
воспроизводит краткий приглушенный сигнал и 
начинает передавать координаты в режиме, 
определённом в пункте «Return Type». Пользователь не 
может ответить на входящий вызов. 
При поступлении SMS, трекер начинает передавать 
координаты в режиме, определённом в пункте «Return 
Type». 

Answer Mode 
(Режим ответа) 

On 

On 

При поступлении входящего вызова, трекер 
воспроизводит звуковой сигнал, и пользователь может 
ответить на звонок.  
При поступлении SMS, трекер начинает передавать 
координаты в режиме, определённом в пункте «Return 
Type». 

Return count 
(Время 

определения 
координат) 

1~10 3 

Время в минутах, в течение которого трекер будет 
пытаться определить позицию. Если позиция не 
определена, в сообщении это будет указано и трекер 
отправит последние зафиксированные координаты. 

Off Трекер будет отвечать на запрос координат с любых 
телефонов. Check Phone List 

(Проверка номера) 
On 

Off Трекер будет отвечать на запрос координат только с 
телефонов, указанных в пунктах «Phone Number1» ~ 
«Phone Number10» (см. ниже) 

On Данные, отсылаемые трекером, содержат местное 
время. Time Zone 

(Местное время) 
Off 

 
Данные, отсылаемые трекером, содержат время UTC 
(Coordinated Universal Time). 

 
Пример текста SMS, отправляемого трекером. 
Position Report:  
TR102 
2005/01/02 11:20:30 
55.7474, 37.6247 
GPS fixed 
 
Строка 1. Тип сообщения: «Position Report» - ответ на запрос координат, «Emergency Report» - пользователь 
нажал кнопку SOS. 
Строка 2. Название трекера, задаваемое в настройках (см. ниже). 
Строка 3. Дата и время определения позиции в формате «yyyy/mm/dd hh:mm:ss». 
Строка 4. Широта и долгота позиции в градусах. Если ввести эти координаты в строку поиска в программе 
«Google Earth» или на странице maps.google.com, отобразится соответствующая позиция на карте. 
Строка 5. Показывает, определена или нет позиция. «GPS fixed» - определена. «GPS not fixed» - не 
определена (при этом дата, время и координаты соответствуют последней определённой позиции). 



Закладка «Phone Return» 
 

 
 

 
 

Пункт Описание 

SOS Number 1~3 
(Номер SOS 1~3) 

Если пользователь нажал кнопку SOS, трекер определит 
позицию и передаст её последовательно в виде SMS на 3 
заданных номера. Могут быть заданы от одного до трёх номеров. 

Quick Dial 1~3 
(Быстрый набор 1~3) 

Если пользователь нажал кнопку быстрого набора, будет 
набран номер, записанный в соответствующем поле. Могут быть 
заданы от одного до трёх номеров. 

 
 
Закладка «Phone List» 
 

 
 
 

Пункт Описание 
Phone Number 1~3 

(Телефон 1~3) 
Эти номера повторяют заданные вами на закладке «Phone 
Return» в пунктах Quick Dial 1~3 (Быстрый набор 1~3). 

Phone Dial 4~10 
(Телефон 4~10) 

Здесь вы можете задать ещё 6 телефонных номеров, с которых 
разрешается получать запрос на определение позиции. 

 
 
Номера телефонов задаются в международном формате, например: 
 
+79161234567 или +74959876543 
 
 
 



Закладка «Information» 
 
 

 
 
 

Пункт Описание 
Module IMEI 
(IMEI номер) 

Уникальный номер GSM-модуля IMEI (International Mobile 
Equipment Identity). 

Firmware Version 
(Версия прошивки) 

Версия прошивки трекера. 

Name 
(Название) 

Произвольное название трекера, которое передаётся в SMS 
сообщении 

Phone 
(Телефон) Номер телефона, соответствующий SIM-карте трекера 

 
 
 
 
 
 
 



Телефон 1 

Телефон 2 

Телефон 3 

8. Работа с трекером 
 
8.1 Включение/Отключение 
 
Для включения TR-101/TR-102, нажмите и удерживайте 3 секунды кнопку 
питания. Процесс включения будет сопровождаться последовательным 
перемигиванием всех трёх светодиодов сверху вниз. После включения будет 
медленно мигать синий светодиод, обозначая дежурный режим GSM модуля. 
После включения GPS модуль будет в течение 3 минут пытаться определить 
текущую позицию, в это время будет мигать зелёный светодиод. Если позиция 
определена, зелёный светодиод загорится на 2-3 секунды и погаснет. Если 
позиция не определена, GPS модуль попробует определить её снова через 30 
минут. Рекомендуем производить включение TR-101/TR-102 на открытом месте для уверенного определения 
координат. 
 
Для отключения TR-101/TR-102, нажмите и удерживайте 3-5 секунд кнопку питания. Процесс отключения 
будет сопровождаться последовательным перемигиванием всех трёх светодиодов снизу вверх.  
 
 
 
8.2 Ответ на входящий вызов/Окончание разговора 
 

• При поступлении входящего вызова буден слышен звуковой сигнал. 
Для ответа нажмите на Кнопку ответа. 

 
• Для окончания разговора нажмите на эту кнопку ещё раз. 

 
 
 
8.3 Регулировка громкости 
 

• Во время разговора нажмите кнопку «+» для увеличения громкости 
динамика. 
 

• Во время разговора нажмите среднюю кнопку для отключения 
микрофона. Если микрофон отключён, собеседник вас не слышит. Для 
включения микрофона нажмите эту кнопку ещё раз. 
 

• Во время разговора нажмите кнопку «-» для уменьшения громкости 
динамика. 

 
Внимание! Для регулировки громкости и отключения/включения микрофона требуется нажатие на кнопку 
длительностью 1-2 секунды. 
 
 
8.4 Исходящий вызов 
 

• Если вы задали с помощью настроечного ПО телефонные номера 
быстрого набора, вы можете вызвать любого из трёх абонентов. Для 
этого нажмите и удерживайте в течение 1 секунды соответствующую 
кнопку.  

 
 
 
 
8.5 Отправка тревожного SMS 
 

• Если вы задали с помощью настроечного ПО телефонные номера для 
отправки сигнала SOS, вы можете отправить тревожное SMS сообщение 
на них. Для этого нажмите и удерживайте в течение 2 секунд кнопку SOS. 

• Для подтверждения правильного нажатия 2 раза мигнёт красный 
светодиод. 

• После этого TR-101/TR-102 попытается определить текущую позицию и 
отправит данные последовательно на заданные номера.  

• В подтверждение доставки SMS трекер мигнёт красным светодиодом. 
• Если TR-101/TR-102 не смог определить текущую позицию, будут 

отправлены SMS с текстом «GPS not fixed» и последними определёнными координатами и временем. 
 
 



 
Как происходит отправка тревожного SMS? 
 

1. Для подтверждения правильности нажатия кнопки SOS, красный светодиод мигнёт 2 раза. 
2. Трекер начнёт определять позицию (мигает зелёный светодиод). Если позиция определена, зелёный 

светодиод останется горящим на 5-6 секунд, после чего погаснет. 
3. Трекер начнёт передачу SMS сообщения (синий светодиод мигает часто). 
4. Трекер переходит в ждущий режим (синий светодиод мигает редко). 
5. Если получено подтверждение доставки SMS, мигнёт красный светодиод. 
6. Если в течение заданного в настройках времени (Пункт «Retourn Count», по-умолчанию – 3 минуты) 

координаты не были определены, трекер отправит SMS с последними определёнными координатами и 
строкой «GPS no fixed». 

 


